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Chapter 1 -(A) 1. (a) 2. (b) 3. (b) 4. (c) (B) 1. COBOL 2. Scientific & Engineering 3. Programmer 4.
Language 5. High (C) 1. (d) 2. (a) 3. (e) 4. (c) 5. (b) (D) 1. True 2. False 3. False 4. True 5. False (E) 1. A
computer language is a means by which instructions and data are transit to computer. Computer
understands instructions written in these languages as these can be easily translated into a machine
level language, which a computer understands. 2. Merits of Assembly Level Language : e It is easier to
understand and use as compared to machine language. e It is easy to locate and correct errors. - It can
be modify easily. Demerits of Assembly Level Language : e It is machine dependent; therefore it
requires that programmer should also have the knowledge of the hardware also. e Assembly level
language program is longer as compared to high level language program. 3. Advantages of High Level
Language : e Programs written in these languages are easier to understand and read than those in
assembly and low level languages. @ Errors in programs written in high level languages are easy to find
and remove. e Programs written for one machine can run on different machines with very minor
changes or no changes at all. 4. Interpreter is a translator program used to convert a high level
language program into machine language line by line, while Compiler translates the whole program at
once. 5. Low level languages are machine oriented languages. These are directly understood by the
computer. These languages are very difficult to understand and instructions in LLL are a tedious job. A
set of LLL written for one type of computer will not work on a computer with different architect. 6.
Generation of Languages: The development of computer languages has been classified into following
categories: (i) Low Level Language: (a) Machine Language (1st Generation) (b) Assembly Language (2nd
Generation) (ii) High Level Language (3rd Generation) (iii) Programming Language (4th Generation) (F)
1. COBOL stands for Common Business Oriented Language. It was introduced in 1960 by US industry
government committee. It is used for business and commercial data processing. 2. C: This language was
developed in 1972 by Bell Laboratories in America. It is a powerful computer language. It uses
structured programming approach. 3. BASIC: Stands for Beginners All Purpose Symbolic Instruction
Codes. It is suitable for scientific and engineering computations. 4. JAVA is a modern day language
developed by Sun Microsystems. It also uses the concept of object-oriented programming. 5. PASCAL is
a general purpose language named after the great scientific Blaise Pascal. It is very powerful computer
language. 6. C++ is sometimes known as an enhancement of the C language. It uses the concept of
object oriented programming. It is also a very powerful language used to develop different applications.

(G) Computer Languages developed in each generation: 1. LOGO : Language of Graphic Oriented
2. BASIC : Beginners all purpose symbolic instruction codes 3. COBOL : Common Business Oriented
Languages 4. JAVA 5. FORTAN: Formula Translation 6. PASCAL : 7. HLL : High Level Language 8. LLL: Low
Level Language (H) 1. BASIC 2. LOGO 3. JAVA 4, C++

Chapter 2 —(A) 1. (c) 2. (b) 3. (b) 4. (a) 5. (b) 6. (a) (B) 1. RAM 2. 700 3. Nibble 4. Bus 5. Slower 6. Fields
7.08& 1(C) 1. (e) 2. (c) 3. (f) 4. (b) 5. (d) 6. (a) (D) 1. False 2. False 3. True 4. False 5. True (E) 1. CD-
ROM is high capacity disc that is used for data transportation. This disc read and write by laser beam
and works at a very high speed. It is an optical storage device that can store large amount of
information. The incredible use of CD has increased its popularity as it can hold text, graphics, sound
and motion pictures. CD's are available in two forms:- (i) CD-R (Compact Disc Recordable)- This drive
allows you to permanently store data on CR-R disc and can be read again and again. Data once
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recorded on it cannot be erased. (ii) CD-RW (Compact Disc Re-writable)- It is also known as erasable CD
or Read Write CD. It is a recording system that allows the user to erase previously recorded information
and then to record new information on the same physical location on the disc. 2. RAM : This memory
works automatically. This is the computer's short term working space used for temporary work. RAM is
like a background in a classroom on which information can be written, erased and re-written. RAM is
read and written in random way, this way, any record can be accessed directly without going through
any other records. 3. (i) Memory Stick: is a digital data storage designed to become a standard storage
and transfer media. The 8 MB memory stick has a minimum of 5 times the storage capacity of a
standard 3.5 inch floppy disc. Due to its compact design, it is best suited for the use in small digital
electronic products. (ii) Flash Drive: is a small storage device that can be used to transport files from
one computer to another. The USB flash drive is a mass storage device which can hold more
information than the traditional floppy disk. (iii) DVD-ROM : It is an optical storage device that looks
similar in size and shape to CD-ROM disc but it has much larger storage capacity than a CD.
Approximately, it can store upto 17 gigabytes of information. The data can only be of read form and
cannot be deleted. 4. RAM — (i) RAM stands for Random Access Memory. (ii) It is a temporary memaory.
(iii) It is a volatile memory. (iv) It has larger storage capacity than ROM ROM — (i) ROM stands for Read
Only Memory. (ii) It is a permanent memory. (iii) It is a non-volatile memory. (iv) It has smaller storage
capacity. 5. Hard disc drive is one of the most important devices just because of its big capacity and fast
accessing storage media. It is an electronic device that can read or write information on its metal or
glass recording surface. It is also called fixed disc that consists of many discs or platters that store data
in tracks, which is further divided into sectors. These discs spin at 7200 rpm (revolutions per minute).
All the programs, which are use frequently, are installed on the hard disc so that just after switching ON
computer they can directly be used without loading from external media like CD. 6. DVD-ROM: It is an
optical storage device that looks similar in size and shape to CD-ROM disc but it has much larger
storage capacity than a CD. Approximately, it can store upto 17 gigabytes of information. The data can
only be of read form and cannot be deleted. You can use DVD-ROM drive to play audio and video. (F) 1.
5/ 5 bytes 2. 6/ 6 Bytes 3. 4/ 4 Bytes 4. 7/ 7 Bytes 5. 8/ 8 Bytes (G) 1. 1024 TB 2. 1 Gigabyte (GB) 3. 1
Kilobyte (KB) 4.1024 GB 5. 1024 KB

Chapter 3 —(A) 1. (b) 2. (a) 3. (c) 4. (b} 5. (a) (B) 1. Worksheet 2. Formatting 3. Shrink & Grow 4. Picture
5. Selecting (C) 1. True 2. False 3. False 4. False 5. False (D) 1. (f) 2. (a) 3. (d) 4. (e) 5. (c) 6. (b) (E) 1.
Inserting Rows : The steps to insert a row in a worksheet are:- (i) Click the row heading to Select the
row above which a row is to be inserted. (ii) Click on Insert button from cells group of the Home tab of
the ribbon. (iii) Click on Insert sheet rows options. A new row gets inserted above the selected rows.
Inserting Columns: The steps to insert a column in a worksheet are:- (i) Select the column to the left of
which a column has to be inserted. (ii) Click on the Insert button from the cells group of the Home tab
of the Ribbon. (iii) Click on the Insert Sheet Columns option. A new column gets inserted to the left of
the selected column. 2. Components of MS-Excel: MS Excel file has the following components: (i)
Workbook and (ii) Worksheet 3. To Change the Font : (i) Select the cells that you want to modify. (ii)
Click on the drop down arrow next to the font command on the Home tab. The font drop down menu
appears. (iii) Move your mouse over the various fonts. A live preview of the font will appear in the
worksheet. (iv) Select the required font. To Change the Font Color: (i) Select the cells that you want to
modify. (ii) Click on the drop down arrow next to the font color command on the Home tab. The color
menu appears. (iii) Move your mouse over the various font colors and click on it. 4. One of the most
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useful features of Excel is its ability to format numbers and dates in a variety of ways. To Format: (i)
Select the cells you want to modify (ii} Click on the drop down arrow next the Number Format
command on the Home tab. (iii) Select the required number format. 5. To insert cells in a worksheet (a)
Click on the cell heading to select the cell to the left where cell has to be inserted. (b) Click on Insert
button from cells group of the Home tab of the Ribbon. (c) Click on Insert Cells option. 6. To add a
border : (i) select the cells on which you want to add the border. (ii) Click on the drop down arrow next
to the Borders command on the Home tab. The border drop down menu appears. (iii) Select the border
style you want to use.

Chapter 4 - (A) 1. (b) 2. (c) 3. (a) 4. (b) 5. {a) (B) 1. Counting 2. Off & on 3. Two 4. Binary 5. Number (C)
1. (c) 2. (d) 3. (e) 4. (a) 5. (b) (D) 1. True 2. True 3. False 4. 5. True (E) 1. Number systems are methods
of counting. They are methods of representing numbers. 2. Binary Number System : Number system
made up of only two symbols, 0 and 1, is known as the Binary Number System. When this system is in
use, every number is formed using 0 and 1. 0 represents “off” and 1 represent “on” condition of an
electrical impulse. Since formation of numbers involves the use of these two symbols, the base of the
binary number system is said to be 2. The symbols 0 and 1 are known as binary digits or bits in short. 3.
To add two binary numbers, use the followingrule: 0+40=0, 0+1=1,1+0=1,1+1=0,carry1To
subtract one binary number from other, use the following rule:1-1=0, 0-0=0, 11-1=10, 10-1
=1, 0-1=1 4. Duodecimal Number System: It is a number system of base twelve. It was felt that this
system was more advantageous than the decimal number system because 12 is better divisible than 10,
It is still in use in our everyday lives. In the concept of dozen, in the 12 month calendar, in the 12 hour
clock. 5. Quaternary Number System is a number system of base four. It is a counting system used by
some ethnic tribes. It is based on the fact that humans and animals possess four limbs. And Quinary
Number System is a number system of base five. It is a system of counting that relies on the use of the
five fingers of a human hand for the purpose. (F) 1. (1001011), 2. (100110), 3. (10000000), 4.
(10110000), 5. (00110101), (G) 1. 22 2. 32 3. 61 4. 25 5. 84 (H) 1. 011000 2. 01000010 3. 01100 4.
0100111 (1) 1.01011 2. 0100110 3. 0101000 4. 1008

Chapter 5 — (A) 1. (c) 2. (c) 3. (b) 4. (c) 5. (a) 6. (c) (B) 1. Program 2. Value & Variable 3. Alphabet 4. Esc
5. One 6. QBASIC (C) 1. (e) 2. (d) 3. (b) 4. (a) 5. (c) (D) 1. True 2. True 3. False 4. True 5. True (E) 1.
Variables : A variable is assigned an area in the memory that can be used to store a value. The value
stored in the variable can be changed during the program execution. You can use the value stored
inside a variable by referring to its variable name. Variable can be of two types. (i) Numeric Variable — A
numeric variable is a variable that stores a numeric constant. (ii) String Variable — A string variable is a
variable that stores a string constant. The length of the string variable can be maximum up to 40
characters. 2. Constants : A constant, as the name suggests, are data or values that does not change
during program execution. The data may be letter, words, numbers and special characters. A constant
can be stored in a variable when it is required to be used in more than one statement or expression.
BASIC has two types of constants: (i) Numeric Constants — Numeric constants are positive or negative
numbers with or without decimal points. Mathematical and logical operations can be performed on
numeric constant. Numeric constant can be integer, long integer, single precision or double precision.
(ii) String Constants — String constants are a sequence of alphabets, digits, characters such as #, %, etc.
enclosed in double quotes. Mathematical operations cannot be performed on string constants.
3. Operators are special functions that are used to perform operations on data. QBASIC provides many
operators that help in performing calculations and comparisons. QBASIC has arithmetic, relational and
logical operators. Arithmetic operators can be used with numeric constants or numeric variables.
Relational operators are used to compare two values or expressions. When you use a relational
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operator the result is either TRUE or FALSE. Logical operators are used to combine two or more
conditions. These operators test the conditions and give a True or False value. The three logical
operators are AND, OR and NOT. 4. Input Statement is used to take value from the user and store it in a
variable. The computer asks for a value by displaying a question mark and puts a cursor on the screen
where the user should type the data and press Enter. Example: REM A program to take two numbers
from the user CLS, INPUT “Enter first number”; a, INPUT “Enter second number”; b, PRINT “You
entered”; a; “and”; b 5. The select case statement can make the code simpler to read and work with
than If statement. Select Case evaluates a comparision check value and execute first matching case or
case Else and Exits. 6. Hierarchy of Operations: Hierarchy defines the order in which the operators are
executed in any BASIC expression. We use BEDMAS for the hierarchy of operation. The full form of
BEDMAS is B Brackets () E Exponentiation » D Division / M Multiplication * A Addition + S
Subtraction — 7. Use of REM Statement: REM stands for remark. The REM statement is used to give
remarks or comments in a program. This statement is not executed. The computer ignores the REM
statement. A single quote can also be used in place of the REM statement. The REM statement can be
used many times in a program. It is a good practice to make use of the REM statement at the start of
the program to explain what the program is all about. (F) 1. 21 2. 15 3. (G) Students will do by
themselves (H) 1. Constants 2. Relational 3. IF THEN 4. INPUT 5. LET 6. 7. String 8. 40 9. String 10.
Logical

Chapter 6 (A) 1. (b) 2. (a) 3. (c) (B) 1. Virtual Reality 2. Dante |l 3. Integrated Chips 4. Robot 5. Emotion
Sensor 6. Computer Programming (C) 1.c 2. a 3. b (D) 1. True 2. False 3. True 4. False 5. True 6. True
(E) 1. A machine that can execute programmed instructions and thus reduce labour or man power is
called a Robot. 2. Robots can be broadly classified into two types Industrial Robots and Service Robots.
3. Industrial Robots are widely used for manufacturing automotives. These robots are programmed
using computers. 4. The field of robotics also explores the possibility of computers associating closely
with human brains. Emotion sensors have been developed that can now recognize the feelings of a
person with their facial expressions. These are robots with artificial intelligence and programmed using
super computers. 5. Robotics has gained a vital role in the environmental sector too. A robot developed
in England can attack insects like certain varieties of carnivorous plants. In addition, an aquarium in
London exhibits a robot that has been inspired by a fish. A robot that has been designed in America can
mimic beetles and cockroaches. 6. The integration of computer programming into the field of robotics
has resulted in amazing technological advancement. Programmed robots can now track cyclones,
weather conditions and also fight bushfires. Active research is on to predict natural disasters in advance
to avoid serious damage and thus protect the victims to the extent possible. 7. The field of mechanics
and electronics together has given rise to a new emerging sector called Mechatronics. Mechatronics is
a multi disciplinary field of engineering that includes a combination of system engineering, mechanical
engineering, electrical engineering, telecommunication engineering, control engineering and computer
engineering. As the technology advances the sub fields of engineering multiply and adapt.
8. Robots have found an important place in the surgical procedures also. Unmanned surgery, remote
surgery and minimally invasive surgery has been possible because of robots. Not only it has reduced
the pain for people, the healing time is very quick and the blood loss is minimal. The surgical
procedures are very precise and the process requires smaller incisions.

Chapter 7 (A) 1. (c) 2. (a) 3. (b) 4. (b) 5. (c) (B) 1. Stage 2. .fla 3. frames 4. Title bar 5. tools (C) 1. d 2. ¢
3.a4.e5. B (D)1 True2. True 3. True 4. False (E) 1. Flash is a multimedia graphic program used for
creating animations and presentations 2. The timeline panel represents a simple mode of visualisation.
It organizes and controls a document's content in layers and frames. Like films, Flash documents divide
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time-length into frames. The timing of an animation is adjusted in timeline panel. Thus, it helps in
setting the sequence of a movie or animation. 3. Pencil mode pop - up menu has (i) Straighten (ii)
Smooth (iii) Ink 4. The various steps to use the Rectangle tool are: e Select the Rectangle tool. e From
the Property Inspector, select the Stroke and Fill attributes. e Click on the Stage and drag to draw a
rectangle. To make a rectangle with round corners, click on the Set Corner Radius button in the Option
Box and enter the corner radius to define the roundness of corners. 5. Various Eraser Mode are:- »
Eraser Normal e Erase Fills ® Erase Lines e Erase Selected Fills e Erase Inside 6. Ink Bottle Tool is used
to change the colour, style and thickness of existing lines whereas Paint Bucket Tool is used to fill
enclosed areas with colour, gradients or bitmap fills. (F) 1. Timeline 2. Text Tool 3. Tool Palette 4. Flash
File 5. Stage (G) 1. e Click Brush tool. e Click down arrow to select the brush size. « Now select brush
shape tool e Choose any brush type and select fill color option and choose color of your choice. After
selection brush size, shape, drag mouse to begin drawing. 2. Follow the steps to fill the shape with
Gradient Colour Fill : e Click the Paint Bucket Tool e Click Fill Colour option in the property inspector
panel. e The Fill Colour Palette opens up. e Select a gradient colour given at the bottom of the colour
palette. o Click inside the shape you want to fill. « The Gradient Colour fills the shape. 3. To erase the
inner part of an object: e Click the Eraser Shape modifier and choose an eraser shape and size. » Drag
on the Stage to erase. 4. To draw smooth line : e Click at Pencil tool. e Click at Pencil Mode Tool. Pencil
Mode pop-up menu has option smooth. Select it. Now move the mouse over the stage area until the
pointer changes from Arrow to Plus e Drag to draw a line of desired length. 5. To draw straight lines: e
Select the Line tool. # From the Property Inspector, select the colour, thickness or line style. @ Click on
the stage, and drag to draw the line. 6. To draw an oval: e Select the Oval tool. « From the Property
Inspector select the property for strokes such as the line style, colour and thickness. e Select the Fill
Colour option and choose the colour you want to fill in. e Click on the Stage and drag to draw the
shape. (H) 1. Line 2. Oval 3. Eraser 4. Rectangle 5. Brush 6. Polystar

Chapter 8 (A) 1. (c) 2. (b) 3. (a) 4. (b) 5. (a) 6. (b) (B) 1. Element 2. HTML 3. Head 4. .HTML or .htm 5.
Properties 6. Opening & Closing (C)1.d 2. a3.e 4. b 5. ¢ (D) 1. True 2. False 3. False 4. False 5. False 6.
7. True 8. True (E) 1. HTML is the most commeonly used language used to write web pages for the World
Wide Web. The major characteristics of this language are: (i) It is easy to understand and modify as it
does not require any programming knowledge. (ii) It requires just a text editor for coding such as
Notepad or WordPad. (iii) It provides more flexible way to design web pages using text. (iv) Links can be
added to the web pages so as to help the readers to visit other web pages of their interest. (v) It offers
compatibility with all web browsers. 2. Basic structure of an HTML document : The basic structure of an
HTML document is given by the following three elements. <HTML> </HTML> <HEAD> </HEAD> <BODY>
</BODY> Head Element: This section appears in the beginning of HTML document which defines HTML
header and does not affect the appearance of the document. Body Element : This is the largest section
of web document which contains information that is displayed on the web page when opened in the
web browser. This information can be in the form of text, graphics or other modes needed to present it
effectively. 3. The Container elements require both starting and ending tags to specify their
presentation on the web page whereas the Empty Tags are the elements which do not need the ending
tag. 4. Commonly used attributes of <Body> tag are : e Background : This attribute in BODY tag is used
to set a background colour of the web page. e Link: This attribute is used to set the colour of unvisited
hyperlinks present in the document. e <BR> Tag : The <BR> tag inserts a single line break. So, when you
want the text to start from a new line you need to use the <BR> tag. « Margins: RIGHTMARGIN and
BOTTOM MARGIN are the other two types of margins which can be added in the HTML document but
these are supported by only few latest web browsers. 5. Head Element: This section appears in the
beginning of HTML document which defines HTML header and does not affect the appearance of the
document. The header contains information about document such as its description, index and name
of program. The browser displays none of the information in the header except for the text contained
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by the sub-element title. The text to be displayed as the title of the document window is given as a
parameter to the title element. Body Element: This is the largest section of web document which
contains information that is displayed on the web page when opened in the web browser. This
information can be in the form of text, graphics or other modes needed to present it effectively. The
format of information is controlled using various HTML elements like fonts, paragraphs, headings, links,
tables, etc. (F) 1. Students will do by themselves.

Model Test Paper 1

(A) 1. (b) 2. (¢) 3. (a) (B) 1. Hard disc drive is one of the most important devices just because of its big
capacity and fast accessing storage media. It is an electronic device that can read or write information
on its metal or glass recording surface. It is also called fixed disc that consists of many discs or platters
that store data in tracks, which is further divided into sectors. These discs spin at 7200 rpm. All the
programs, which are used frequently are installed on the hard disc so that just after switching ON
computer they can directly be used without loading from external media like CD. 2. Interpreter is a
translator program used to convert a high level language program into machine language line by line,
while Compiler translates the whole program at once. 3. Components of M5-Excel: M5 Excel file has the
following components: (i) Workbook and (ii) Worksheet 4. Number systems are methods of counting.
They are methods of representing numbers. 5. (i) Memory Stick : is a digital data storage designed to
become a standard storage and transfer media. The 8 MB memory stick has a minimum of 5 times the
storage capacity of a standard 3.5 inch floppy disc. Due to its compact design, it is best suited for the
use in small digital electronic products. (ii) Flash Drive: is a small storage device that can be used to
transport files from one computer to another. The USB flash drive is a mass storage device which can
hold more information than the traditional floppy disk. (iii) DVD-ROM: It is an optical storage device
that looks similar in size and shape to CD-ROM disc but it has much larger storage capacity than a CD.
Approximately, it can store upto 17 gigabytes of information. The data can only be of read form and
cannot be deleted. (C) 1. byte 2. cell 3. five 4. Number systems 5. Scientific & engineering (D) 1.d 2. a
3.e4.c5.b (E) 1. True 2. True 3. False 4. True 5. False (F). 1. (1100011), 2. (1110000), 3. (1000001},

Model Test Paper 2

(A) 1. Robotics has gained a vital role in the environmental sector too. A robot developed in England
can attack insects like certain varieties of carnivorous plants. In addition, an aquarium in London
exhibits a robot that has been inspired by a fish. A robot that has been designed in America can mimic
beetles and cockroaches. 2. HTML is the most commonly used language used to write web pages for
the World Wide Web. The major characteristics of this language are: (i) It is easy to understand and
modify as it does not require any programming knowledge. (ii) It requires just a text editor for coding
such as Notepad or WordPad. (iii) It provides more flexible way to design web pages using text. (iv)
Links can be added to the web pages so as to help the readers to visit other web pages of their interest.
(v) It offers compatibility with all web browsers. 3. The Container elements require both starting and
ending tags to specify their presentation on the web page whereas the Empty Tags are the elements
which do not need the ending tag. 4. The time line panel represents a simple mode of visualisation. It
organizes and controls a document's content in layers and frames. Like films, Flash documents divide
time-length into frames. The timing of an animation is adjusted in time line panel. Thus, it helps in
setting the sequence of a movie or animation. 5. Constants: A constant, as the name suggests, are data
or values that does not change during program execution. The data may be letter, words, numbers and
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special characters. A constant can be stored in a variable when it is required to be used in more than
one statement or expression. BASIC has two types of constants: (i) Numeric Constants Numeric
constants are positive or negative numbers with or without decimal points. Mathematical and logical
operations can be performed on numeric constant. Numeric constant can be integer, long integer,
single precision or double precision. (ii) String Constants String constants are a sequence of alphabets,
digits, characters such as #, %, etc. enclosed in double quotes. Mathematical operations cannot be
performed on string constants. (B) 1. (a) 2. (c) 3. (c) (C) 1. True 2. True 3. True 4. False 5. True (D) 1.
Value 2. -- 3. 1996 4. Notepad or WordPad 5. INPUT (E) 1. e) 2. a) 3. b) 4. ¢) 5.d) (F) Ren A program to
calculate area of a Rectangle. CLS L=5, B =8. PRINT "The Area of Rectangle is" L *B

Class - 7 }

Chapter 1 (A) 1. (a) 2. (d) 3. (b} (B) 1. Fraud 2. Information Technology 3. E-governance 4. E-learning
(C) 1. (d) 2. (c) 3. (a) 4. (b) (D) 1. True 2. False 3. False 4. True (E) 1. ICT: Information and
Communication Technology is the technology that provides access to information through telecomm-
unications. 2. Information Technology is a methodology of system in which information of any kind may
be taken from or given to another part located anywhere in the world. 3. Scope of Information and
Communication Technology: In the past few decades, ICT has made communication a very fast and
simple procedure. People can communicate with anyone across the world and at any time using
technologies such as instant messaging, chat rooms, video conferencing etc. It has acquired an

important status in today's world. Its usefulness is now immensely felt in various fields. Trade and
commerce always depend on appropriate information for their success. You will find applications of ICT
in almost all spheres of life such as education, business, health-care, agriculture, governance, art,
employment, transport, space and environment study etc. 4. (a) E-commerce: is buying, selling and
exchange of goods and services over computer networks, predominantly on the Internet.
(b} E-governance: refers to the use of modern information and communication technologies such as
Internet, smart phone, mobiles, local networks, etc. by govt. to improve its effectiveness, efficiency and
service delivery. (c) E-learning: uses electronic media and ICT to enable people to learn anytime and
anywhere by providing course material, training, guidance from experts and conducting examinations.
Chapter 2 (A) 1. (c) 2. (a) 3. (b) 4. (c) (B) 1. F11 2. Column 3. Bar 4. Line (C) 1. (c) 2. (a) 3. (d) 4. (b) (D)
1. True 2. False 3. True 4. False (E) 1. Chart is an effective way to represent data in pictorial form. A
good graph or chart displays information quickly and easily to the user. Components of a chart : (i) Data
Label (ii) Data Table (iii) Chart Area (iv) Legend (v) Data Points 2. Bar Chart displays data in the form of
long, rectangular rods called bars of different heights, displayed either vertically or horizontally. It
shows comparisons among individual items, whereas A Column Chart shows the data changes over a
period of time or illustrates comparisons among items. This is one of the commonly used charts in
which the data is represented in the form of vertical bars. 3. To move a chart: You can move the chart
from one location to another on the same worksheet or on a different worksheet by pointing anywhere
on the chart and drag it to the location you want to move. 4. To create a chart: There are two ways to
create a chart in MS Excel 2007 : Method 1 : First select the cells and press F11 key. Excel automatically
creates a chart for you and new Chart Tab appears along with the sheet tabs. Method 2: To create a
chart of your choice, follow the steps given below : e Enter the data in a worksheet e Select the cells
within the table o From the Charts group of buttons, choose any chart type, say Column chart « Now,
select the chart subtype from the drop down list. This creates the desired chart for you on the current
worksheet.
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Chapter 3 (A) 1. (c) 2. (a) 3. (c) 4. (d) (B) 1. Facts & figures 2. Database 3. Table 4. Datatype (C) 1. (c) 2.
(d) 3. (a) 4. (b) (D) 1. True 2. True 3. True 4. True (E) 1. Elements of A Database: A database consists of
the following three elements:- (a) Table (b) Field (c) Record 2. DBMS: A database management system
is software that helps to manage large amount of data. It involves creating, modifying, deleting and
adding data in database in such a way that users can retrieve and manipulate data efficiently and
quickly. DBMS allows users to create their own database according to their requirements. In, RDBMS,
we have multiple tables and the relationship between these tables can be created using commaon
fields. 3. DBMS: A database management system is software that helps to manage large amount of
data. It involves creating, modifying, deleting and adding data in database in such a way that users can
retrieve and manipulate data efficiently and quickly. DBMS allows users to create their own database
according to their requirements. Types of DBMS: There are four types of DBMS: - (a) Hierarchical (b)
Network (c) Relational (d) Object-Oriented 4. Functions of DBMS: A database may consist of multiple
files. A DBMS provides centralized control over multiple files, eliminating data redundancy, data
inconsistency etc. The main functions of DBMS are :- (i) Eliminates Data Redundancy (ii) More
Consistency in Data (iii) Increased Data Security (iv) Imposes Integrity Constraints (v) Provides Multiple
Views (vi) Facilitates Sharing of Data (vii) Enforces Standards (viii) Provides Backup and Recovery

Chapter 4 (A) 1. (c) 2. (d) 3. (c) 4. (b) (B) 1. Common 2. Primary Key 3. .accdb (C) 1. (b) 2. (c) 3. (a) (D)
1. False 2. False 3. True 4. True (E) 1. Backstage View: The Backstage view is the new interface
component that you see when you click the File tab on the ribbon. From the Backstage View, you can
manage your database that is you can create, save or set options for the database. It features all the
information that you need to know about your document. You can also access recent database from
the pane, open new database and print reports. 2. Primary key of a Table: A primary key is a unique
identifier for a particular record. Every table must have one of the fields as the primary key of the table
and each table can have only one primary key. Generally, a primary key is a number but it can be of any
data type. The value in the column acting as a primary key is always unigue for that column, that is, it is
listed only once in the table. Also, the column which is the primary key for a table must always have a
data value. It cannot be left blank or have a value as null. 3. M5-Access : is a Relational Database
Management System (RDBMS) which provides a simple yet robust way to manage data. The data in M5S-
Access is stored in the form of tables and is arranged in the form of rows and columns. There are
multiple tables in M5 Access database and relationships are created between these tables using
commmon fields. Components of MS- Access Window: There are various components that may be used
for a variety of tasks. (i) Title Bar (ii) Ribbon (iii) Quick Access Toolbar (iv) Backstage View (v} Navigation
Pane (vi) Document Tab Bar (vii) Status Bar (viii) Record Navigation Bar 4. Opening a Database: To open
an existing database, follow the steps given below:- e Click File tab and select the Open option. The
Open dialog box appears. o Select the drive ad folder which contains your database. e Select the
desired database and click the Open button. Saving a Database:- e To save the database, select Save
Database As option from the File Tab. e The Save As dialog box appears. Type the name of the database
file in the File name text box. e Click Save. The database will be saved with an extension .accdb.

Chapter 5 (A) 1. (a) 2. (b) 3. (c) (B) 1. 2. Vector 3. Selection 4. Multimedia (C) 1. (c) 2. (d) 3. (a) 4. (b)
(D) 1. False 2. True 3. False 4. True (E) 1. Flash is a multimedia graphic program used for creating
animations, games, cartoons, text, graphics and other special effects. It is basically used as a design tool
for creating animations, especially Web pages. Components of Flash Window: e Title Bar and Menu Bar
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e Tool Palette @« The Stage « Work Area e Property Inspector Window e Timeline Panel e Layers Panel 2.
Symbol : A symbol is any object that is stored within the movie. It is reusable and is stored in the Flash
Library. This means it can be inserted in the movie for a number of times. This is done by the use of an
instance. The copy of the symbol is called the Instance. Each time you insert a symbol that gets
inserted. 3. Use of selection tool : The selection tool might seem simple, but it is actually quite useful.
It is used to select parts of the object or drag over a portion of it to create a selection rectangle. 4.
Steps to use Text Tool : e Select the Text Tool - There are options to choose the font style, colour size,
alignment, etc. in the Property Inspector Panel. e Select the desired font style, colour, size etc. e Bring
the mouse pointer on the stage, The cursor changes into a '+' sign. e Click and drag the mouse pointer
to get a text box of desired length. e A cursor appears in the beginning of the text box.
e Type the text. 5. Moving an Object : To move the selected object simply follow these steps:
e Click on the selected portion. A Plus (+) sign appears. Drag and move the selected portion to a new
place. e Release the mouse button. The cut-out portion moves to a new location. Copying an Object :
To make a copy of an object, follow thse steps: e Click on the selected portion. e Select Copy option
from the Edit menu. The right click on blank area on the Stage and select Paste Option. The object is
copied at a new location.

Chapter 6 (A) 1. (b) 2. (b) 3. (a) (B) 1. Guide layer 2. Layers 3. F5 & F6 4. Timeline (C)1.d2.e3.a4.¢c
5.b (D) 1. True 2. True 3. True 4. False (E) 1. Motion guide is a feature in Flash & that is similar to
motion tween but in this case, the object can be animated along a definite hand-drawn path. This path
is called guide layer. This is the path along with an object moves. Motion Guide is nothing but moving
your symbol in a predefined path such as a curve or circle and thus creating an animation effect.
The various steps to create Motion Guide: e Create a graphic symbol or drag a pre-existing graphic
symbol from Library onto the Stage. Name the layer as “ball”. You can also take a picture from MS -
Word Clip Art and paste it in Flash. e Right click on the “ball” label and select “Add Motion Guide” from
the pop-up window. e A new layer will appear on the top of the “ball” layer with the label “Guide:ball”
along with the guide icon. e Draw the path for your symbol in this new layer using pencil or line tool. e
Select Frame 50 of Guide layer and press “F5" to insert frames. ® Now, go to “Frame 1" of “ball” layer
and drag your symbol to one end of your path. While dragging, you will see a bubble on the symbol.
That bubble should go right below the path. ¢ Now, go to “Frame 507 of “ball” layer and press F6 to
insert a new keyframe. o Now, drag your symbol to the other end of your path. Again, the bubble
should go right below the path. e Select any frame between 1 to 50 of your “ball” layer. Right click and
select “Motion Tween” from the pop-up menu. e Press the keys Ctrl + Enter together to view your
work. Save your work by pressing Ctrl = S keys and test the movie by pressing the keys (Ctrl + Enter)
2. Frames are represented as a series of vertical rectangles on top of the Timeline. Every fifth frame has
light grey fill and is marked with a frame number which is written at the top of the Timeline. To insert a
frame in your movie, press F5 whereas Keyframe are the frames with black dots. A keyframe is a critical
point in the animation. It is the point where any change in the object is reflected. To insert a keyframe
press FB. 3. In a Flash window, Timeline is a fixed pane above the workspace where you actually work
with frames. The object is various frames are controlled, sequenced and organised through the
Timeline to form an animated movie. 4. To create Tween Animation follow the various steps : e Create
the Object to be Animated-Open a new Flash file and draw the object on the Stage. Convert it into a
symbol by choosing Modify Convert to Symbol buttons on the Flash window (or press F8). A Convert to
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Symbol box appears. Click OK to convert the object into a symbol. « Now, create the first and the final
stages of animation. The Timeline contains a keyframe on Frame 1. To create your animation, you need
to insert a second keyframe further along the Timeline. Click on Frame 20 of the Timeline and select
Insert Timeline Keyframe options. @ Make sure you have the keyframe at Frame 20 selected. Move
your object to another location on the stage. & Select any Frame between 2 to 19 and select Motion
from the tween pop-up menu in the Property Inspector. At this stage, if you select Control Test Movie,
you should see your ball moving gradually from the first position to the second position. You can vary
the time that ball takes to move by clicking on the keyframe at the Frame. To play the movie, select
Control Play option.

Chapter 7 (A) 1. (d) 2. (c) 3. (c) (B) 1. Unordered List 2. Left 3. 4., Cell spacing (C)1.c2.d3.a4.b (D)
1. True 2. False 3. True 4. True (E) 1. Ordered List (ol) is a list of related items where the order holds
importance. Since, the items are given a sequence in the form of numbers or alphabets, the list is also
known as the numbered list whereas, Unordered List (ul) is a list of related items where order is not of
much importance and so items are not displayed in a particular order. It is also known as a bulleted list.
2. Cell Spacing is the space between two adjacent cells where as Cell Padding is the distance between
the edge of the cell and the contents of the cell. 3. Caption Tag is a container tag; it allows you to nest
other HTML tags. All markup tags are possible inside the <CAPTION> tags, although some would not
make much sense. <CAPTION> tags have one attribute, ALIGN = “TOP” and “BOTTON". 4. Some of the
attributes of table which can be used and are useful than others are listed below: (i) ALIGN : The ALIGN
attribute is used to determine where the chart will appear relative to the browser window, valid values
are ALIGN = RIGHT, ALIGN = LEFT etc. (ii) WIDTH : The WIDTH attributes the relative or absolute width
of your table in the browser window. Value can be either percentage as in WIDTH = “40%" or absolute
values. (iii) COLS: The COLS attributes specifies the number of columns in your table, allowing the
browser to draw table as it downloads. (iv) BORDER: Border and Border Color The border attribute
draws a border of specified thickness around the table. The value of this attribute is in pixels. The
default value of border attribute is zero that is no border is displayed around the table to be created.
Chapter 8 (A) 1. (a) 2. (b) 3. (b) 4. (a) (B) 1. Loop 2. Instructions 3. While 4. Print 5. Exit (C}1.b2.d 3. a
4, c (D) Students will do by themselves. (E) 1. The sequence of instructions which keep on repeating is
called loop. These are also called iteration statements. The types of loops in QBASIC are - (i) While ----
Wend loop (ii) Do ---- While loop (iii) Do ----Until loop (iv) For ---- Next loop (v) Nested loop 2. Program
to print even numbers from 10 to 100 as For x = 10 to 100 STEP 2 PRINT x Next x 3. & 4. Students will
do by themselves.

Chapter 9 (A) 1. (c) 2. (b) 3. (b) (B) 1. A,B,C,D,E,F 2. Divide 3. Four (C) 1. (c) 2. (a) 3. (d) 4. (b) (D) 1. True
2. False 3. True (E) 1. The Octal Number System consists of 8 digits i.e. 0 to 7 with the base 8. The
procedure of octal to decimal conversion is similar to 'binary to decimal' conversion. The only
difference is the change of base. The symbols 0 to 7 are known as Octal Digits. 2. Hexadecimal Number
System is made up of sixteen symbols 0 to 9 and A to F. When this system is in use, every number
system is formed using 0, 1, 2, 3, 4, 5,6, 7, 8 9, A, B, C, D, E and F. Since numbers involve the use of
these sixteen symbols, the base of the hexadecimal number system is said to be 16. The symbols are
known as Hexadecimal Digits or Hexa Digits in short. 3. Binary Addition: It consists of four entries: A
very simple technique is used to add Binary numbers inside the computer. Binary addition is similar to
Decimal addition. In Binary addition, if the sum if two numbers exceeds 1, a carryover will be
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generated. 0+0=0,0+1=1,1+0=1,1+1=0carry 1 Carry over since 1 is the largest digit in the
binary system, only seem greater than 1 requires that a digit can be carried over. Example: Add (111),
and (101), 4. In Hexadecimal Number System symbols represent values like A for 10, B for 11, C for 12,
D for 13, E for 14 and F for 15. (F) 1. 8 2. (16B),, 3. (553), 4.

Chapter 10 (A) 1. (d) 2. (a) 3. (c) (B) 1. C2B 2. Online frauds 3. Online 4. Downloading (C) 1. (c) 2. (d) 3.
(a) 4. (b) (D) 1. False 2. True 3. True 4. True (E) 1. Commerce is involved with buying and selling of
products. You can see commerce all around. It may take different forms. Three different types of people
are involved with commerce are: Producers, Sellers and Buyers. 2. E-Commerce: Electronic commerce
or e-commerce is the buying, selling and exchange of goods and services over computer networks,
predominantly on the Internet. The transactions exchange of data for such business transactions and
terms of sale are all performed electronically. Advantages and Disadvantages of E- Commerce :
Disadvantage : i. Extra security measures have to be taken to avoid online fraud and misallocation of
funds. Advantages : i. It is available round the clock and 365 days a year. ii. You can choose products
from worldwide market. iii. You do not need to carry cash from home to shop with fear of losing it. iv. It
is cost-efficient for businesses as it helps in reducing costs. 3. There are four categories of E-Commerce
available at present. These are: (i) Business to Business (B2B) (ii) Business to Customer (B2C) (iii)
Consumer to Business (C2B) (iv) Consumer to Consumer (C2C) 4. Uses of Internet in the field of
Education: Now-a-days, many educational institutes from all over the world provide online educational
facility. Internet makes it possible to learn in an environment where the teachers and the students are
not needed at the same place or in a classroom. Some institutes conduct online tests for their courses.
You can appear in an examination from your home sitting in front of your computer with simply an
Internet connection. Distance education becomes easier and affordable with the use of Internet.

Chapter 11 (A) 1. (c) 2. (a) 3. (d) 4. (c) (B) 1. Payload 2. Hard disk 3. Antivirus 4. AVG & Norton (C) 1. (c)
2. (e) 3. (a) 4. (b) 5. (d) (D) 1. False 2. 3. False 4. False (E) 1. A destructive software program or piece of
code that disrupts the normal operation of a computer is known as a virus. What a virus can do:
Computer viruses are man-made. Viruses enter the computer without the knowledge of the user
Viruses become active only when the infected program or application is used. Once active, they are
loaded onto the computer's memory. When a computer is infected with a virus, its resources such as
data and programs are either corrupted or deleted. This affects the normal functioning of the
computer. The action which a virus performs on a computer is called its payload. 2. Viruses usually
spread through the use of infected pen drives, email attachments ad while downloading from the
Internet. Viruses begin to work and spread whenever you start up an infected program or application.
To avoid quick detection, they are secretly hidden. Computer viruses usually spread in one of three
ways : (i) From removable media (ii) From files downloaded from Internet (iii) And from e-mail
attachments. 3. Viruses are of many types as below: e Resident Viruses e Direct Action Viruses e
Overwrite Viruses e Boot Viruses e Directory Viruses e File Infectors # Worms e Trojans or Trojan Horses
Resident Viruses: These viruses are permanent. They dwell in the RAM and damage all those files and
programs which are available on the system. Overwrite Viruses: These viruses damage or remove the
data present on those documents that they infect and thus making them useless at last. The only
option left is to delete that useless file. 4. Virus infections are dangerous for a computer system.
Measures should be taken to avoid virus infections. Some of the precautions which can be taken to
avoid computer virus infections are as follows: (i) An antivirus software should always be installed and
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updated regularly. Make it run every time your system is booted. (ii) Use original antivirus software as
pirated or copied software is likely to suffer from a virus attack. (iii) Use the Internet and e-mail
attachments carefully. (iv) Always download files from reliable Internet websites and be careful while
using pen drives as they might carry harmful viruses.

Model Test Paper 1

(A) 1. (c) 2. (a) 3. (c) 4. (d) (B) 1. ICT 2. E-commerce 3. Column chart 4. Table 5. Database (C) 1. (d) 2. (f)
3. (e) 4. (b) 5. (c) 6. (a) (D) 1. True 2. True 3. False 4. True (E) 1. ICT : Information and Communication
Technology is the technology that provides access to information through telecommunications.
2. Advantages of Internet : # We can send and receive information across large matrix of computer
systems. Through email service, we can send messages for both business and personal purposes. e
Internet has opened doors for virtual online offices.  During the festive season, we don't need to visit
crowed stores to buy our stuff. We can make online purchases at a bargain price. « We can send
birthday greeting cards through the internet. e Before making any purchases, we can check online for
user reviews of the products that we intend to buy. 3. Chart is an effective way to represent data in
pictorial form. A good graph or chart displays information quickly and easily to the user. Types of charts
in MS-Excel are : (i) Column Chart (ii) Line Chart (iii) Pi Chart (iv) Bar Chart (v) Area Chart (vi) Scatter
Chart etc. 4. Bar Chart displays data in the form of long, rectangular rods called bars of different
heights, displayed either vertically or horizontally. It shows comparisons among individual items,
whereas A Pie Chart shows one data series in the form of the comparative size of things that make up
the data series to the sum of the items. The data in this type of chart is displayed in the form of a circle
which is divided into sectors. 5. MS Excel has the following components — Workbook, worksheet and
cells. @« Workbook : It is a collection of multiple worksheets stored under a single name. When you save
an MS Excel document, you are saving a workbook. « Worksheet : Just as a book has a number of
pages, an MS5-Excel workbook has a number of sheets called worksheets. It is a work area made up of
horizontal rows and vertical columns where in you enter and work with data. The default names of
worksheets in a workbook are sheet 1, sheet 2, sheet 3. The name of the sheet currently in use, called
the active sheet and is indicated in bold. An MS-Excel worksheet contains 65,536 rows and 256
columns. e Cells : Cell is the most basic unit of worksheet. It is formed by intersection of a row and a
column. Vertical divisions are called columns whereas the horizontal divisions are known as rows.

Model Test Paper 2

(A) 1. (c) 2. (a) 3. (b) 4. (b) (B) 1. Internet 2. Plot 3. Primary 4. Timeline Panel 5. Lasso (C) 1. (c) 2. (a) 3.
(d) 4. (e) 5. (b) (D) 1. False 2. True 3. True 4. True (E) 1. E-commerce: is buying, selling and exchange of
goods and services over computer networks, predominantly on the Internet. The transactions,
exchange of data for such business transactions and terms of sale are all performed electronically. This
is one of the most effective and efficient ways of conducting business nowadays. The web is rapidly
becoming a multibillion dollar source of revenue for the world's businesses. Companies set up website
that provides details of their products and services. Consumer then buy the desired products using
credit cards, debit cards, net banking, cash o delivery etc. 2. Advantages of Internet: The Internet is so
far one of the greatest inventions of all time. The Internet has made it possible for us to do lots of
things. People can shop in online stores like ebay, communicate with family and friends via skype and
so much more. Internet is very useful to us. It is like a big library. You can exchange views and ideas
with other people on Internet. 3. Selection Tool: The selection tool might seem simple, but it is actually
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quite useful. It is used to select parts of the object or drag over a portion of it to create a selection
rectangle. Lasso Tool: This tool is useful when you want to select shapes that are too close to objects
you don't want to select or when you want to select irregular form. This tool allows you to draw around
the shape, selecting everything contained in the shape you draw. 4. Ordered List (ol) is a list of related
items where the order holds importance. Since, the items are given a sequence in the form of numbers
or alphabets, the list is also known as the numbered list. In an ordered list, the <ol> element is used to
form the list. It works in the same way as the <ul> element but instead of adding a circle or a square,
an ordered list uses number or letters. The type of numbering or alphabetical scheme that you want to
use is specified using the TYPE attribute. Using an ordered list, you can have the list with Arabic
numbers, letters or Roman numerals. 5. Types of Layers: There are three types of layers which can be
created in Flash: Normal, Guide and Guided, Mask and Masked.

Model Test Paper 3

(A) 1. (c) 2. (b) 3. (a) 4. (c) (B) 1. E- Governance 2. Shape 3. Status 4. Auto Number 5. A file (C) 1. (b) 2.
(d) 3. (e} 4. (c) 5. (a) (D) 1. True 2. False 3. False 4. False 5. True (E) 1. A destructive software program
or piece of code that disrupts the normal operation of a computer is known as a virus.
Viruses usually spread through the use of infected pen drives, email attachments or while downloading
from the Internet. Viruses begin to work and spread whenever you start up an infected program or
application. To avoid quick detection, they are secretly hidden. Computer viruses usually spread in one
of three ways: (i) From removable media (ii) From files downloaded from Internet (iii) And from e-mail
attachments. 2. E-learning: uses electronic media and ICT to enable people to learn anytime and
anywhere by providing course material, training, and guidance from experts and conducting
examinations. Advantages of E-learning: (i) Scalable E - learning enables us to quickly create and
communicate new policies, training, ideas, and concepts. Be it for entertainment or formal education,
e-learning is nimble! (ii) Capacity and Consistency — Using e-learning allows educators to achieve a
great degree of coverage for their target audience, and it ensures that the message is communicated in
a consistent fashion. This results in all learners receiving the same training. (iii) High Learning Retention
— Blended learning approaches result in a higher knowledge retention rate. It also helps that course
work can be refreshed and updated whenever needed. (iv) Time and Money Savings — This one is
pretty well known, and a staple of any well-done e-learning program. E-learning reduces time away
from the workplace, eliminates the need for travel, and removes the need for classroom-based training.
3. Animation is the rapid display of sequence of 2D or 3D images in order to create an optical illusion of
movement. The animation effect is caused due to the phenomenon of persistence of vision. It can be
created and demonstrated in several ways. 4. Types of List in HTML: Three types of lists can be created
in HTML. These are as follows: (i) Unordered Lists (ii) Ordered Lists (iii) Description List or Definition
Lists. 5. Some of the Antivirus software are: Norton, AVG, Quick Heal and Kaspersky:.

Model Test Paper 4

(A) 1. (a) 2. (a) 3. (c) 4. (a) (B) 1. E Commerce 2. Memo 3. Guide & Guided 4. LEFT 5. Frames (C) 1. (c)
2. (a) 3. (d) 4. (b) 5. (e) (D) 1. False 2. True 3. 4. True 5. True (E) 1. ICT: Information and Communication
Technology is the technology that provides access to information through telecommunications. ICT has
made distance learning possible. Various e learning sites provide study materials and tutorials. Also,
many universities are now conducting online courses and examinations. This is very helpful for students
who cannot attend a regular course in schools and colleges. 2. HTML stands for Hyper Text Markup

If.;] O Input Qutput (Computer Knowledge)




Language. It is the most commonly used language used to write web pages of World Wide Web. Basic
structure of HTML document.

<HTML>

<HEAD> </HEAD>
<BODY> </BODY>
</HTML>

3. Timeline is a fixed pane above the workspace where you actually work with frames. The objects in
various frames are controlled, sequenced and organised through the Timeline to form an animated
movie. Timeline panel has these components : e« Playhead o Frames e Current Frame e Keyframe 4. Cell
Spacing is the space between two adjacent cells. It specifies the amount of space between the frame of
the table and the cells in the table. Cell Padding is the distance between the edge of the cell and the
contents of the cell. To control the horizontal alignment of the text and images within table cells align
attribute is used. You can increase the amount of padding for all cells using the cell padding attribute
on the table element.

Class - 8 )_...

Chapter 1 (A) 1. (a) 2. (c) 3. (b) 4. (b) (B) 1. MAN 2. Bus 3. Data 4. Infrared 5. Intranet (C) 1. True 2.
True 3. False 4. False (D) 1. Computer networking is a concept where two or more computers are
connected with each other through some communication medium to share their information and
resources with each other. The computers connected in a network can communicate with each other
as well as they can also work independently. 2. Wired Network Technology: (i) Co-axial Cable — A co-
axial cable is generally used to transmit TV signals from an antenna to our TV sets. It consists of a
copper wire core surrounded by an insulating material, which is in turn copper wire surrounded by an
outer conductor. Finally, there is an outer plastic jacket covering wire. (ii) Twisted Pair Cable — Twisted
pair consists of a pair of insulated wires twisted together. Because of the twist between the two wires
it reduces the electromagnetic interference. Wireless Network Technology: (i) Bluetooth — Bluetooth
technology is a global short range communication technology which uses radio waves to exchange
signals between the devices. This is mainly used to connect mobile devices like cell phones, laptops,
tablets, etc. to help them exchange their data with each other in a Personal Area Network. (ii) Wi-Fi
Wi-Fi is a wireless technology that uses high frequency radio waves to allow high speed data transfer
over a short distance. It is basically used to establish Wireless Local Area Network (LAN) for providing
wireless Internet access to the mobile users with the help of Wi-Fi hotspot. Just like Bluetooth, this
technology is also used in cell phones, laptops, PDA's tablets, etc. Wi-Fi hotspot acts like an access
point for accessing network services as one hotspot can provide access to 30 users within a range of
100 to 300 feet. 3. To connect the computers in a network, various types of hardware components
are needed depending upon the type of network. These hardware components are: (i) Network
Interface Card (NIC) (i) Transmission Medium (iii) Hub (iv) Switch (v) Router (vi) Connector 4.
Advantages of using wi-fi are : a) This is a wireless connection that can merge together multiple
devices b) It is useful in cases where the wiring is not possible. (c) It is faster and cheap. 5. LAN or
Local Area Network is a network of two or more computers and peripheral devices spread within a
small geographical area like a room, office, building or a campus. The size of this network can range
from 0 to 10 kms. While WAN or Wide Area Network is used to interconnect computers across larger
geographical areas like two cities or states or even across different countries or continents. WAN is
generally established by the large organisation, having offices spread across the country or in different

If5_ O Input Qutput (Computer Knowledge)




countries. 6. LAN (Local Area Network): is a network of two or more computers and peripheral
devices spread within a small geographical area like a room, office, building or a campus. The size of
this network can range from 0 to 10 kms. MAN (Metropolitan Area Network): is a larger network as
compared to LAN. It covers a metro or a city. MAN is used to connect the offices of an organisation
spread across the city. The medium used to connect the computers in MAN is similar to that in LAN.
As it covers larger area than LAN, the cost involved in setting up a MAN is higher than LAN. Size of a
MAN can range from 10 to 50 kms. WAN (Wide Area Network): is used to interconnect computers
across larger geographical areas like two cities or states or even across different countries or
continents. WAN is generally established by the large organisation, having offices spread across the
country or in different countries. 7. Internet is formed with the words inter (between) and net
(network), between the different networks. Internet is a network of networks which is spread
worldwide. This network is open for the general public and they can use it to share the information
and communicate with one another whereas, Intranet means Intra (within) Net (network), it is a
private network which is within a particular organisation. The information available on this network
may be the general or confidential, meant to be distributed among the employees if that organisation
only. So, it is a kind of private Internet not accessible to the general public, but is used by the
organisation to circulate some information among its employees, to conduct online meetings or
trainings etc.

Chapter 2 (A) 1. (b) 2. (c) 3. (a) 4. (c) (B) 1. Operating System 2. Mobile 3. Multiuser and Multitasking
4. Touch screen 5. Real time (C) 1. False 2. True 3. True (D) 1. Operating System is the first program
that is loaded into computer's main memory when a computer is switched on. It acts as an interface
between user and computer, so that user can easily interact with the hardware components of the
computer system to get their work done. It also performs many routine jobs in the computer like
memory management, processor management, resource management, etc. Major components of the
Operating System are: e Hardware e The Operating System e Application Software e The Human ware
(Users) 2. Types of Operating System: Based on the functionality of Operating System it can be
categorized as: (a) Single User Operating System: Operating system which allows only one user to use
the system resources and only one job can be processed by the CPU is known as single user operating
system. (b) Multiuser Operating System: Operating system that allows multiple users to use the
system resources simultaneously is called multiuser operating system. It is also known as
multiprogramming operating system. (c) Multitasking Operating System: This type of operating
system allows simultaneously execution of the multiple jobs at a time by the CPU. (d) Real Time
Operating System: This type of operating system is used where the jobs are required to be finished
within a time frame. The two main features of Real Time Operating System are quick response and
reliability. 3. LINUX is one of the UNIX like operating systems which is open source free software
which is developed by a community consisting of a number of companies and group of people called
volunteer programmers. It can be downloaded from internet without any cost. Features of LINUX are:
e Free and Open Source : LINUX is an open source, free licence software that means anyone can copy
the software, use and see its source code, modify it and redistribute it.  Virus Resistant : LINUX is
designed such that it is almost considered as virus free because it is made so hard that it is almost
impossible for any virus to get through this operating system. e Multiple Workspaces : Just like
Windows 7, which provides Desktop as workspace for the user, LINUX also provides workspace. e
Reliability : LINUX does not suffer with the problems like hanging or system crash. It is more reliable
to work with as compared to Windows. 4. Mobile Operating System or Mobile OS is an operating
system specially designed to run on mobile devices like mobile phone, smart phone, tablets, etc. They
provide platform to run other application or programs on mobile devices. Some of the popular mobile
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operating systems are Android, Blackberry, iPhone OS, Symbian, Windows mobiles etc. 5. Memory
Management function of operating system helps to optimize the performance of the CPU. Operating
system efficiently manages the available memory in the computer. It allocates the space to various
data items and programs in the main memory of computer using different techniques so that these
can be recalled quickly and easily by CPU. And when jobs finished or closed it also reallocates the
memory. (E) 1. (e) 2. (c) 3. (d) 4. (a) 5. (b)

Chapter 3 (A) 1. (c) 2. (b) 3. (a) 4. (c) (B) 1. Title 2. Project 3. Frame Control 4. Document Window (C)
1. True 2. False 3. True 4. False (D) 1. (d) 2. (c) 3. (a) 4. (e) 5. (b) (E) 1. Visual Basic (VB) is a
specialized object oriented computer language that you can use to develop simple to complicated
windows based (GUI) applications for the computer. It is a part of the Visual Studio Application
Package. It is one of the very powerful programming systems. Visual basic is actually a BASIC language
which is visual in its nature. 2. How to start Visual Basic 6.0: To start Visual Basic, the steps are given
below: e Click 5tart menu e Click on All Program option e Click on Microsoft Visual Basic Studio 6.0 e
Click on Microsoft Visual Basic 6.0 # Microsoft Visual Basic 6.0 window appears. 3. Components of
Visual Basic Window: (i) Title Bar: It is the top bar displaying the title of the project. (i) Menu Bar
and Pull Down Menus: The horizontal bar displayed below the title bar is the menu bar. It contains
menus like File, Edit, View, Project, Format etc. (iii) Toolbar: A toolbar is a bar that displays icons for
commonly used tasks. The standard toolbar of Visual Basic displays icons for the most frequently used
commands in Visual Basic. (iv) Form Design Window: A form is a main part of the project. This is
where you design your application. (v) Toolbox: A toolbox is a window that displays a set of tools that
may be used to place controls on a form. (vi) Project Explorer: The project explorer window shows
the list of forms and modules in a project. (vii) Properties Window: The properties window is used to
set the properties for the objects in the project. (viii) Form Layout Window: The Form Layout
Window shows that how big a form is in relation to the screen. (ix) Context Menu: These are the
shortcut menus that contain shortcuts to frequently performed actions. (x) Code Editor Window: The
Code Editor Window is where the Visual Basic Code for your application is written. 4. IDE: Visual Basic
provides Integrated Development Environment (IDE) i.e. many features like designing, editing,
compiling, debugging within the common environment. 5. (i) CheckBox : The check box control lets
the user select or unselect an option. When the check box is checked, its value is set to 1 and when
it is unchecked: its value is set to 0. (ii) ComboBox : The function of the combo box is to present a list
of items where the user can click and select the items from the list. (iii) ListBox : The function of the
list box is to present a list of items where the user can click and select the items from the list.

Chapter 4 (A) 1. (b) 2. (c) 3. (a) 4. (b) (B) 1. Numeric 2. 2 Bytes 3. Arithmetic 4. Logical (C) 1. True
2. False 3. True 4. False (D) 1. (c) 2. (a) 3. (d) 4. (b) (E) 1. Variables are named areas of memory
allocated to store data. You have to use variables in any programming language to store different
types of data. 2. Declaring Variable means telling the Visual Basic to reserve memory space. A
variable can be declared as per following syntax: Dim <Varname> [as <Datatype>] 3. A Function
procedure is a series of Visual Basic statements enclosed by the Function and End Function
statements. A Function procedure can take arguments, such as constants, variables, or expressions,
which are passed to it by the calling code. The MsgBox () Function: The MsgBox function displays a
message in a dialog box, waits for user to click a button, and then returns an integer indicating which
button the user clicked. 4. Logical operators are used for making decision based on multiple
conditions. 5. Sequence: The sequence construct means the statements are being executed
sequentially. This represents the default flow of statement. Selection: The selection construct means
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the execution of statement (s) depending upon a condition-test. If a condition evaluates to true, a
course of action is followed otherwise another course of action is followed. This construct is called
decision construct because it helps in making decision about which set of statements is to be
executed. Iteration: Iteration is typically used to refer to collections and arrays of variables and data.
Iteration means to visit every item in the collection, usually in order but may be in an irregular order
however each item is visited only once. The iteration construct is also called looping construct. 6. Exit
Statement: Exits a procedure or block and transfers control immediately to the statement following
the procedure call or the block definition. Exit Do: 'Exit Do' statement can be used only inside a Do
loop. Execution continues with the statement following the Loop statement. Exit For: Immediately
exits the For loop in which it appears. Execution continues with the statement following the Next
statement. Exit For can be used only inside a For....Next or For Each....Next loop.
Exit Select: Immediately exits the Select Case block in which it appears. Execution continues with the
statement following the End Select statement. Exit Select can be used only inside a Select Case
Statement. Exit While: Immediately exits the While loop in which it appears. Execution continues with
the statement following the End While statement. Exit While can be used only inside a While loop.
When used within nested While loops, Exit While transfers control to the loop that is one nested level
above the loop where Exit While occurs. (F) 1. Valid 2. Invalid 3. Invalid 4. Invalid 5. Valid (G) 1. If-
Then-Else constructions let you test one or more conditions and run one or more statements
depending on each conditions, while Select Case statement can be used when multiple If statements
become messy and difficult to read. 2. Do While Loop is used when to test a condition first and if the
condition evaluates to true then only you want to repeat the statements, while Do Loop While works
little differently. Unlike the first Do loop, the loop body in this loop is executed first before evaluating
<comparison_test>. If <comparison_test> is true, VB repeats the loop body. Otherwise, VB exits the
loop and executes the statement of loop code. Do Loop While executes the loop body at least once.
This is an Exit Controlled loop. 3. And: Results will be true if all the conditions are true while in Not,
results will be opposite of the condition.

Chapter 5 (A) 1. (d) 2. (c) 3. (a) (B) 1. Java 2. Encapsulation 3. Object (C) 1. True 2. True 3. False (D)1.
(d) 2. (c) 3. (a) 4. (b) (E) 1. Java is a programming language which was originally developed by Sun
Micro Systems which was initiated by James Gosling and released in 1995 as core component of Sun
Microsystems' Java platform. Java runs on more than 850 million personal computers worldwide and
on billions of devices worldwide including mobile and TV devices. 2. Features of Java

e Simple : Java is designed to be easy to learn. If you understand the basic concept of OOFP Java
would be easy to master. « Object Oriented : In Java, everything is an object. Java can be easily
extended since it is based on the object model. # Robust : Java makes an effort to eliminate error
prone situations by emphasizing mainly on compile time error checking and runtime checking. e
Dynamic : Java is considered to be more dynamic than C or C++ since it is designed to adapt to an
evolving environment. Java programs can carry extensive amount of run-time information that can be
used to verify and resolve access to objects on run-time. e Secure : All the programs in Java are run
under an area known as the sand box. Security manager determines the accessibility options of a
class like reading and writing a file to the local disk. « Portable : Being architectural-neutral and
having no implementation dependent aspects of the specification makes Java portable. Compiler in
Java is written in ANSIC with a clean portability boundary which is a POSIX subset. 3. Object is similar
like a real life entity such as table, chair, pen etc. Every entity has its behaviour and attributes. When
a program is executed, the objects interact by sending message from one to another. Class : A class is
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a blue print from which individual objects are created. Class is a building block of Java. It is a logical
way to group together fields that hold values and associated methods that operate on these fields
into a single unit. 4. Data Abstraction : Abstraction is another good feature of OOPS. As per
dictionary, abstraction is the quality of dealing with ideas rather than events. Abstraction is a process
of hiding the implementation details from the user, only the functionality will be provided to the user.
In other words, user will have the information on what the object does instead of how it does it. In
Java, abstraction is achieved using Abstract Classes and Interfaces. Encapsulation is one of the four
fundamental OOP concepts. Encapsulation in Java is a mechanism of wrapping the data (variables)
and code acting on the data (methods) together as a single unit. In encapsulation the variables of a
class will be hidden from other classes, and can be accessed only through the methods of their
current class, therefore it is also known as data hiding. (F) 1. POLYMORPHISM 2. OBJECT
3. ABSTRACTION

Chapter 6 (A) 1. (d) 2. (b) 3. (c) 4. (c) (B)1. Name 2. Internal and External 3. Hypertext Reference
4. HREF (C) 1. False 2. True 3. True 4. False (D) 1. (c) 2. (d) 3. (a) 4. (b) (E) 1. A hyperlink is a word,
group of words, or image that you can click on to jump to another document. When you move the
cursor over a link in a Webpage, the arrow will turn into a little hand. The Link Tag <A> is used to
define the hyperlink in HTML. It is also known as anchor tag, as it is used to create anchors for links.
2. Internal Linking: Links section of the document i.e. upon clicking a hyperlink, a different section of
the document becomes visible in the Web Browser. External Linking : Links two documents, i.e. upon
clicking a hyperlink, a new document, to which the hyperlink is linked, is opened. 3. ALINK: is an
active link. This attribute is used to give color to an active hyperlink. A link is active when you have
clicked it but have not released the mouse button. 4. You can insert any image in your web page by
using <img> tag. Following is the simple syntax to use this tag. <img src="Image URL"... attributes-
list/> The <img> tag is an empty tag, which means that it can contain only list of attributes and it has
no closing tag 5. Forms : HTML forms are used to take data as input from the users and pass them to
server. The user input can be in the form of text, numbers, images etc. A form can contain input
element like text field, text area, check box and radio button, and some action buttons and more.
HTML forms are required when you want to collect some data from the site visitor e.g. registration
information: name, e-mail address, credit card, etc. and then will post to your back end application.
Here, required processing is done on that data. The <Form> Tag tells the browser where the form will
start and end. You can add all kinds of HTML tags between the <form> and </form> tags. This means
that a form can easily include a table or an image along with the form fields.

Chapter 7 (A) 1. (b) 2. (c) 3. (a) 4. (c) 5. (b) 6. (a) (B) 1. Horizontal 2. Arabic 3. Ordered 4. Comment
5. Left 6. <Font> (C) 1. 2. 3. 4. 5. True 6. 7. (D) 1. (e) 2. (d) 3. (a) 4. (b) 5. (c) (E) 1. HTML provides
various text formatting tags to work with font setting and to add special effects like bold, italic,
underline, superscript, subscript etc. <B> Bold Tag: <B> tag has no attribute and it simply changes the
text to bold typeface which helps in highlighting important contents of the document. <SUP>
Superscript Tag: This is a special text formatting tag which is used to display the text in the
superscripted format. The superscripted text appears slightly above the normal text line. <SUB>
Subscript Tag: This tag is also one of the container tag just like <SUP> which has no attribute but it is
used in the HTML document to display the enclosed text or character in subscripted form i.e., slightly
below the normal text line. This format is generally used to represent chemical formulae or symbol. 2.
HTML Heading Tags: Sometimes you need to change the appearance of the text in terms of its sizes
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or thickness. HTML leading elements provide six levels of heading tags <H1> to <H6>. The level 1
heading style i.e. <H1> is the most prominent heading style and is used to represent top level
headings whereas <H6> is the least prominent heading style. The utility of this tag is in a web page
that has various heading and subheadings categorising the contents of web page.

<H1> This is First Level Heading. </H1>
<H2> This is Second Level Heading. </H2>
<H3> This is Third Level Heading. </H3>
<H4> This is Fourth Level Heading. </H4>
<H5> This is Fifth Level Heading. </H5>
<H6> This is Sixth Level Heading. </H6>

3. Ordered List: An ordered list is used to create a sequential list of items. Ordered list is also known
as numbered list. It is used to create a sequential list of items i.e. list in which each item is placed at
specific position. The items in such a list are preceded by a unique number which tells the position or
preference of individual item in that list. Attributes of OL: An ordered list is created using Arabic
numerals starting with number 1 by default, <OL> supports two special attributes i.e. TYPE and START.
TYPE: This attribute can be used to change the numbering style. The attribute can take five different
values to display the list items in five different numbering styles. START: This attributes is used when
the number list is to be started with some number other than 1. The value of this attribute must be a
positive integer. 4. Definition List: This type of list is used to organise the items and their descriptions
in the HTML web page. In this, each item has two parts: a term and its definition. HTML provides
<DL> tag to create such type of lists. It is a container tag that encloses all the terms and their
description marked with <DT> and <DD> tags respectively.

Syntax: <DL>
<DT> Terml </DT=>
<DD> Term 1 Description </DD>
<DT> Term2 </DT>
<DD> Term 2 Description </DD>
</DL>

5. Attribute of <P> Tag: The only attribute of this tag is ALIGN which can take any of the three values
i.e., LEFT, RIGHT or CENTER to align the enclosed paragraph lines towards left, right or center of the
page horizontally.

Syntax: <P ALIGN = “ LEFT/RIGHT/CENTER">
Text
Text </P>

6. Superscript <SUP>: This is a special text formatting tag which is used to display the text in the
superscripted format. The superscripted text appears slightly above the normal text line. This is a
container tag and is mostly used to display the mathematical terms like 10" or (x+y)" as the web page
contents. Syntax: <SUP> text </SUP> (F) 1. An ordered list is used to create a sequential list of items.
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Ordered list is also known as numbered list. It is used to create a sequential list of items i.e. list in
which each item is placed at specific position. The items in such a list are preceded by a unique
number which tells the position or preference of individual item in that list whereas, Unordered List is
known as unnumbered list. It is an indented list with a bullet symbol in front of each list item. It is
also known as bulleted list and is used to present the list items in an organised manner irrespective
of their position in the list i.e., the items can appear anywhere in the list. 2. <SUP> Superscript Tag:
This is a special text formatting tag which is used to display the text in the superscripted format. The
superscripted text appears slightly above the normal text line, whereas, <SUB> Subscript Tag: This tag
is also one of the container tag just like <5UP> which has no attribute but it is used in the HTML
document to display the enclosed text or character in subscripted form i.e., slightly below the normal
text line. This format is generally used to represent chemical formulae or symbol. 3. Bold Tag <B> has
no attribute and it simply changes the text to bold typeface which helps in highlighting important
contents of the document whereas in Underline Tag <U> text gets highlighted with a line that runs
under the enclosed text in the web page. 4. H n tag is used provide six levels of heading tags to
change sine or thickness of text whereas Font tag is used to change the color and size of text. 5. <P>
tag is used to display the text of the webpage in paragraph format whereas <BR> tag simply breaks
the text from the new line without any extra spacing. G. & H. Students will do by themselves.

Chapter 8 (A) 1. (b) 2. (c) 3. (a) 4. (c) 5. (b) (B) 1. Software 2. 1709 3. 70 4. Nature and degree 5.
Copyright (C) 1. True 2. False 3. False 4. True 5. False (D) 1. (b) 2. (c) 3. (e) 4. (d) 5. (a) (E) 1.
Plagiarism is the stealing of ideas, thoughts or writings of someone else and using them by one's own
name. Types of Plagiarism: e Ghost Writing e Photocopying e Self stealer Plagiarism 2. Privacy deals
with the rights of an individual to keep his personal information secret from others and disclosing
only the selective one. The internet allows us to share a lot of information with our friends and
relatives. Most of this information is personal and users do not want these details to be viewed or
accessed by other people whom they don't know. 3. Ways to avoid Plagiarism: Plagiarism can be
avoided by keeping in mind certain points while using information from any other source like:  Take
permission from the author e Use Quotations e Acknowledging the sources e Read and Reframe. 4.
Copyright: Copyrights are the rights of an author on his creative work or an artist on his artwork to
protect them from its unauthorised recreation or reproduction of their work. 5. ICT (Information and
Communication Technology): refers to the technology that provides access to the information
through high speed communication like Internet, wireless network, cellphone and others. Benefits of
ICT: The applications of Information and Communication Technology (ICT) into daily human activities
have made tremendous impact on both businesses and individuals. ICT is applied in almost every
aspect of human life. The key benefits of ICT in some of the field are as follows: e Education e Health
e Governance » Virtual Schools « Economy 6. Careers in IT: It includes all the aspects of managing and
processing information and technologies related to it. The real world of IT can be found in every field
ranging from home to business, entertainment to communication, health care to finance or
manufacturing to retailing everywhere. o System Analyst: The job of a system analyst involves
researching, planning, coordinating and recommending software and system choices to meet an
organisations business requirement. « Web Designer: Web Designer designs web pages and websites
for WWW. They are professionals who solve a client's communication problem and leverage the
clients brand identity in a very specific way. « Computer Engineers: This is a technical job which
needs high level technical skills to provide support to the end users of the product. To support a user
wide range of hardware and software knowledge is needed. (F) 1. Plagiarism 2. Ghost writing 3.
Copyright 4. Privacy 5. Copyright 6. Software developer 7. DBA
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Model Test Paper 1 (A) 1. To insert a Frame in the form: e Click on Frame control on the toolbox and
drag on the form (also draw three radio buttons in the frame). o In the properties window, change
the frame's and radio button's Caption property. 2. Functions : A function procedure is a series of
Visual Basic Statements enclosed by Function and End Function Statements. The function procedure
performs a task and then returns control to the calling code. 3. Exit Statement: Exits a procedure or
block and transfers control immediately to the statement following the procedure call or the clock
definition. Exit Do: 'Exit Do' statement can be used only inside a Do loop. Execution continues with
the statement following the Loop statement. Exit For: Immediately exits the For loop in which it
appears. Execution continues with the statement following the Next statement. Exit For can be used
only inside a For....Next or For Each....Next loop. Exit Select: Immediately exits the Select Case block
in which it appears. Execution continues with the statement following the End Select statement. Exit
Select can be used only inside a Select Case Statement. Exit While: Immediately exits the While loop
in which it appears. Execution continues with the statement following the End While statement. Exit
While can be used only inside a While loop. When used within nested While loops, Exit While
transfers control to the loop that is one nested level above the loop where Exit While occurs. 4.
Operating System is the first program that is loaded into computer's main memory when a computer
is switched on. It acts as an interface between user and computer, so that user can easily interact
with the hardware components of the computer system to get their work done. It also performs
many routine jobs in the computer like memory management, processor management, resource
management, etc. Major components of the Operating System are: e Hardware e The Operating
System e Application Software « The Human ware (Users) Types of Operating System: Based on the
functionality of Operating System it can be categorized as: (a) Single User Operating System:
Operating system which allows only one user to use the system resources and only one job can be
processed by the CPU is known as single user operating system. (b) Multiuser Operating System:
Operating system that allows multiple users to use the system resources simultaneously is called
multiuser operating system. It is also known as multiprogramming operating system. 5. Network
topology refers to the layout in which various computers are connected with one another in a
computer network. There are three basic network topologies. These are: e Bus Topology e Star
Topology e Ring Topology (B) 1. MAN 2. Main memory 3. Forms and modules 4. Declaration 5. Data
(C) 1. True 2. True 3. False 4. True 5. False (D) 1. (b) 2. (a) (E) 1. Students will do by themselves (F) 1.
ListBox: The function of the list box is to present a list of items where the user can click and select
the items from the list. 2. CheckBox: The check box control lets the user select or unselect an option.
When the check box is checked, its value is set to 1 and when it is unchecked; its value is set to D.

Model Test Paper 2 (A) 1. Java is a programming language which was originally developed by Sun
Micro Systems which was initiated by James Gosling and released in 1995 as core component of Sun
Microsystems' Java platform. Java runs on more than 850 million personal computers worldwide and
on billions of devices worldwide including mobile and TV devices. Features of Java: ¢ Simple: Java is
designed to be easy to learn. If you understand the basic concept of OOP Java would be easy to
master. e Object Oriented: In Java, everything is an object. Java can be easily extended since it is
based on the object model. e« Robust: Java makes an effort to eliminate error prone situations by
emphasizing mainly on compile time error checking and runtime checking. « Dynamic: Java is
considered to be more dynamic than C or C++ since it is designed to adapt to an evolving
environment. Java programs can carry extensive amount of run-time information that can be used to
verify and resolve access to objects on run-time. e Secure: All the programs in Java are run under an
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